
 

Accessible Document Practices in Adobe Acrobat Pro 

Todd M. Weissenberger, University of Iowa 

Adobe Acrobat lets you create documents in Portable Document Format (PDF) from a variety of sources.  

Acrobat PDFs are easy to distribute, and remain faithful to the design and layout of the original. 

Here are a few tips and tricks to help you provide more accessible PDF documents for your students and 

others. 

Accessible Instructional Materials: PDF ........................................................................................................ 3 

Potential PDF Accessibility Barriers .............................................................................................................. 3 

Start with Accessible Source Documents ...................................................................................................... 4 

PDF Accessibility Tasks .................................................................................................................................. 4 

Key PDF Accessibility Factors ........................................................................................................................ 4 

Acrobat Accessibility Tools ............................................................................................................................ 5 

Converting Image-Only Documents to Text .................................................................................................. 6 

Adding Tags to an Untagged Document ....................................................................................................... 7 

Setting Reading Order ................................................................................................................................... 8 

Manage Reading Order in Navigation Pane .................................................................................................. 9 

Add Headings and Other Tags ..................................................................................................................... 10 

Generating Bookmarks from Page Structure .............................................................................................. 11 

Provide Alternative Text for Figures and Images ........................................................................................ 12 

Document Properties .................................................................................................................................. 13 

Use the Make Accessible Wizard ................................................................................................................ 14 

 





 
 

Accessible Instructional Materials: PDF 

PDF (Portable Document Format) is a popular and commonly-used format for 

the delivery of visually formatted documents, typically intended for printing. 

PDF documents may be created in one of several ways, and may contain text, 

images, and other kinds of common document objects.  Depending on the 

content and construction of a PDF, it may pose significant accessibility barriers 

to some users, including users of assistive technology. 

Potential PDF Accessibility Barriers 

Scanned PDF 

A scanned PDF contains no tags, structure, or other information to provide content or context to AT 

users. The scanned PDF presents a major accessibility barrier, and should not be distributed without 

significant remediation. 

Untagged Text PDF 

Untagged text PDFs include content that may be exposed to assistive technology, but that lacks 

structure, semantics, or order. Untagged PDFs must be tagged and checked for content order before 

distribution. 

PDF with Images 

PDFs may contain images that are intended to convey important information to users. These images 

must be accompanied by a text alternative, so that users are able to determine the purpose or function 

of the image. 

PDF with Tables 

PDFs may contain tables that are intended to convey important tabular data to users.  If the table does 

not convey the relationship of header and data cells, or if the table is very complex, users may be unable 

to determine the context of a given cell or data point. 

PDF lacking a Page Title 

PDFs should contain a Page Title in the Document Properties, which is exposed to assistive technology 

when the document is opened.  This information assists the user to understand the purpose of the 

document.  If the Page Title is missing, the user may not understand the purpose of the document. 

PDF with Forms 

PDFs are often used to deliver forms for print or online completion.  Form elements must be 

appropriately labeled to convey their purpose to assistive technology.  If form elements are unlabeled or 

improperly labeled, users may be unable to determine the purpose of the form elements. 

PDF with Embedded Multimedia 

Embedded multimedia is likely to lack captions, keyboard operable players, and screen reader support.  

Multimedia embedded in PDF should be avoided altogether. 
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Start with Accessible Source Documents 

The Portable Document Format is a destination form for documents created in a variety of source 

applications.  In many cases, documents are created in Microsoft Word, PowerPoint, Adobe InDesign, 

and other authoring applications. These documents may carry accessibility features with them when 

they are exported to PDF.  

Repurposed documents 

PDFs come from a variety of sources, and not all will include accessibility features that carry forward 

after conversion. Also, documents that have been scanned or otherwise converted from one document 

format to PDF may require more remediation. In some cases, it may be best to return to the source 

document to add or improve features. 

Make Sure PDF is the right format 

You want to make sure that PDF is the right format for what you’re trying to achieve.  PDF forms and 

other interactive documents may require a higher level of development time and effort.  You might 

consider distributing your document in a different format altogether—common alternatives to PDF 

include Word and HTML 

PDF Accessibility Tasks 

• Create PDFs from accessible source documents 

• Run the Acrobat Accessibility Checker or similar assessment tool 

• Check to see whether the document is scanned 

• Check whether and how the document is tagged 

• Check navigation, bookmarks, tab order, page order 

• Check and address alternative text 

• Check document properties: security, language, title 

• Check tables, forms, media and other embedded objects 

• Check for unwanted content and create artifacts 

• Touch Up Reading Order (TURO) 

Key PDF Accessibility Factors 

• Machine-readable text: NOT image-only 

• Logical reading order 

• Semantic and structural tags, including artifacts 

• Navigability: appropriately nested headings, bookmarks 

• Keyboard operable: no mouse required 

• ALT text for images 

• Sufficient color contrast 

• Document properties and security  
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Acrobat Accessibility Tools 

Acrobat Accessibility Checker 

Acrobat's accessibility checker checks up to 32 accessibility factors in your 

document.  You can select options in four categories and view the resulting 

report. 

Note: The first time you use Acrobat Pro's Accessibility tools, you may need to 

issue the command through the Tools menu (View→Tools→Accessibility).  

Now, the Accessibility tools are available in the Tools pane. 

You can run accessibility checks using the “Full Check” command, and the 

results will appear in an Accessibility Checker panel for review. 

Some accessibility issues can be remediated using the Make Accessible 

Wizard, and some can be addressed via Reading Order, Add Tags, and other tools. The most effective 

way to remediate an inaccessible PDF is to make changes in the source document where possible. 
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Converting Image-Only Documents to Text 

Documents that have been scanned to PDF, printed to PDF, or generated through some third-party PDF 

makers may render as image-only files. These documents have no machine readable text, but only a flat 

representation of the text and other content from the original document. These documents are not 

searchable, they cannot be edited, the text cannot be extracted for citations or other purposes, and they 

cannot be read by assistive technology such as screen readers. 

To make such documents more usable, you can perform Optical Character Recognition (OCR) on your 

document. Either the Enhance Scans toolset or the Edit PDF toolset can work for this purpose. In this 

tutorial, we will use the Enhance Scans toolset. 

Enhance Scans 

The Enhance Scans toolset lets you select a text output option, along with a few other features. The 

Enhance Scans toolset is located in the Acrobat Tool Center. To use the Enhance Scans/Recognize Text 

tool: 

1. Open the Enhance Scans toolset 

2. Apply any settings, including pages, language, output, and resolution 

3. Press OK to run the OCR process 

 

Note: performing OCR is not sufficient to claim accessibility, but it’s a good and necessary start. In 

addition, the quality of text from this process may vary widely, depending on the quality of the original 

document. Be prepared to work with other aspects of the document, including tags and reading order. 
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Adding Tags to an Untagged Document 

Tags add structure and semantic meaning to elements in your PDF, which means that users of assistive 

technology can more easily determine what an element does, what it means, and how it might relate to 

the rest of your document. Headings, paragraph markers, figure and image designations, lists, tables, 

and artifacts are all examples of tags. 

First, you need to determine whether your document 

is already tagged. This information is found in the File 

menu, under Properties. Select the “Description” tab, 

and check in the “Advanced” property set. 

Add Tags 

If the document is not tagged, you can add tags.  

• Select the “VIEW” menu 

• Select “Show/Hide” 

• Select “Navigation Panes”, and then “Tags” 

• If the “Tags” pane reads “No Tags Available”: 

o Right click on the “No Tags” icon; 

select Add Tags to Document 

o Use the Make Accessible Wizard to 

add tags 

 

 

Check your Tags panel 

This method places tags in your document, but you still may need to check your tags manually to make 

sure your document is properly structured. 
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Setting Reading Order 

A logical and accurate reading order is vital for the accessibility of your PDF. Even if your document is 

text-based and tagged, you still may need to adjust the reading order to ensure that the document is 

screen and machine-readable. You can use the “Touch Up Reading Order” tool to move through your 

document and correct any issues with reading order. 

The accompanying screen shots illustrate 

what a document might look like after OCR 

and tagging. Note that the page order runs 

across columns, into sidebars, and splits 

unpredictably in ways that obscure the text 

order and readability of the content. “TURO” 

lets you manually correct reading order 

issues by selecting and retagging blocks of 

content. 

The Reading Order tool is located in the 

Accessibility tools pane. 

Touch Up Reading Order 

• Select “Reading Order” from the 

Accessibility tools pane 

• To view your document’s reading 

order, select the “Show Order 

Panel” button 

• If you want to start fresh with your 

page structure, select the “Clear 

Page Structure” button 

• Draw a rectangle around any 

element you wish to update, and 

select the button that describe that 

element 

• You can also right click on an order 

number and select a tag from the 

context menu 
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Manage Reading Order in Navigation Pane 

Although your PDF document may look fine, the background data may not accurately reflect the logical 

reading order of the document. The Navigation Pane, and particularly the Tags panel and the Order 

panel, let you manage tags, reading order, and bookmarks to provide a reliable reading order for all 

users, including users of assistive technology.  

Change reading order using the Order panel 

• In the navigation panel, activate the Order pane; a reading order overlay appears on the 

document 

• Drag and drop items in the Order pane until the document overlay reflects your intended 

reading order. 

• In the screen shots below, note that the items in the Order panel reflect the visual page order. 

• For elements that you want to exclude from the reading order, select “Background” to create an 

Artifact. 
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Add Headings and Other Tags 

As with other document formats, you can 

greatly improve navigation and access in 

PDF by providing a logical reading order 

and robust semantic structure. Screen 

reader users are able to traverse a 

document effectively using headings; 

other users may benefit from Bookmarks 

navigation.  

If you created your PDF from a well-

developed source document, you should 

already have a robust heading structure in 

place. With the Reading Order panel, you 

can take advantage of up to six heading 

levels, and other tags 

The Reading Order panel lets you view 

your document’s reading order, and update tags for headings, figures, table structure, and other aspects 

of your document. You can also create artifacts to hide unwanted content from assistive technologies. 

After you have established the general reading order for your document, consider reviewing the 

document and adding structural tags where appropriate. 

Artifacts 

For elements that you want to exclude from the reading order, select “Background” to create an 

Artifact. Artifacts are elements that are removed from a document’s content order and placed in the 

background, where they are not exposed to assistive technologies. Artifacts are particularly useful in the 

remediation process, as you can use them to hide indicia like page numbers, gutter shadows, decorative 

images, and other superfluous remnants of the original document. 
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Generating Bookmarks from Page Structure 

One benefit of a well-structured document is that readers can quickly locate specific information by 

scanning the document’s topic headings. Users of assistive technology are beneficiaries of well-defined 

document outlines, as are people who prefer to scan a table of contents or landmark list to quickly find 

the content they want. 

Your bookmark structure is directly influenced by the markup choices you make when you add headings 

using the Touch Up Reading Order tool.  

Generate Bookmarks from a selection 

To generate a bookmark from a selection: 

• Open the Bookmarks navigation pane 

• Select (highlight) the text you want the 

bookmark to point to 

• Select the Add Bookmark tool in the 

navigation pane (Ctrl+B) 

• Enter the name of the Bookmark 

• Repeat the process until you have 

created the bookmarks you want 

Generate Bookmarks from Structure 

If your document structure is consistent and robust, you may want to create a group of bookmarks all at 

once. To generate bookmarks from structural elements: 

• Open the Bookmarks navigation pane  

• In the “Options” menu, select “New Bookmarks from Structure” 

• Select the element from which you want to create bookmarks 

• Label your Bookmark set as desired 
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Provide Alternative Text for Figures and Images 

As with other document formats, PDF permits the use of alternative text (ALT text) with embedded 

images and figures.  Photographs, illustrations, charts and graphs, logos, and diagrams are a few 

examples of embedded images that rely on ALT text to convey their meaning to assistive technology. 

To edit or add ALT text in Acrobat, you need to select the image (or figure) for which you want to 

provide the text.  

Add ALT text from the tags tree 

• Reveal the tags navigation pane 

(View→Show/Hide→Navigation 

Panes→Tags) 

• In the Tags pane, locate the Figure tag 

for which you want to provide ALT text 

• Right click on the Figure element and 

select properties 

• Enter your ALT text for this element 

• Pro tip: when the Touch Up Reading 

Order panel is active, you can right click 

on Figures and add ALT text 
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Document Properties 

PDF documents include several properties that can help users remain oriented as they open and move 

through them. 

Title: The Title property is announced to the user when the document is opened. A relevant and 

meaningful Title property lets the user know which document has been opened. The Title property is 

exposed to the user when the Show option reads “Document Title” in the Initial View tab. 

Language: Defining the human language of a document lets screen readers provide correct 

pronunciation and inflection when rendering human languages.  This property is especially important for 

documents that use multiple languages. The language property can be set in multiple places in Acrobat, 

including the Advanced tab in Document Properties. 
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Use the Make Accessible Wizard  

The Make Accessible Wizard is one of the Action Wizards available in Acrobat 

DC.  The "Make Accessible Wizard" guides you through a series of actions that 

can mitigate the barriers found in some PDF documents, including many that are 

addressed elsewhere in this tutorial. The Wizard is a good place to start 

remediating an existing PDF, but you will probably still need to modify some tags 

manually to normalize the structure of your document. 

The Make Accessible Wizard provides an automated means of adding tags and 

other accessibility features to your document. For best results, you should 

review the tags, title, and other information to make sure it meets the needs of 

your document and your users. Note also that the Make Accessible Wizard will 

overwrite any accessibility features you may have previously included in your 

document.  

To run the Make Accessible Wizard 

• From the Tools pane, select the Action Wizard 

• In the Actions list, select “Make Accessible” 

• For each step in the Make Accessible Wizard, provide appropriate 

information 

• Review the information and proceed with further remediation as 

necessary 

 

 

 

 

 

 

 

 

 

 

 


